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About
The ACD Agent Module will configure itself in Agent mode, based on the user's logon name. 
When the Agent Module logs onto the ACD Controller Module, the logon name is tested to 
see the job classification of the person logging on. If the person who logs on is only an 
Agent (as opposed to a Supervisor or an Administrator), then certain functions will be 
turned off or made inaccessible. 
Shown below is the Main Screen of the ACD Agent Module.

Pages

Administrator Manual - Introduction(see page 5)
Administrator Manual - Usage(see page 6)
Administrator Manual - Menu Bar Items(see page 15)
Administrator Manual - Customizable Screen Pop Interfaces(see page 35)
Administrator Manual - MiniTAP(see page 36)
Administrator Manual - Non-Call ACD Objects(see page 37)
Administrator Manual - Hours of Operation(see page 48)

Copyright
The information in this document is subject to change without notice. T-Metrics, Inc. assumes no responsibility for any errors or 
omissions that may appear in this document.
TM-2000 and PhoneGroups are trademarks of T-Metrics, Inc. 
Microsoft, Microsoft Word, Microsoft Access and Microsoft Windows are trademarks of Microsoft Corporation. 
All materials are Copyright  ©2008 -  2020 T-Metrics, Inc. 

If you have any questions or comments, please contact: 
T-Metrics, Inc.
Customer Service
4430 Stuart Andrew Boulevard
Charlotte, North Carolina 28217 USA
Phone: +(1) 704.525.5551
Fax: +(1) 704.525.4886
EMail: sales@tmetrics.com1 
Or visit our Web site at: 
www.tmetrics.com2 
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Administrator Manual - Introduction

The TM-2000 ACD / Call Center is designed to be the primary point of contact an organization has with its callers, providing a quick 
and efficient method to obtain the person in the organization who is most qualified to handle callers' needs. Its integral parts consist 
of:

Agents (representatives who answer the calls)
Supervisors (people who view Agents and Queue statistics)
Administrators (people who control call flow and manage the call center)
Hardware and software to distribute calls to the appropriate Agents

The Agents use a PC to make themselves "Available", make inquiries and look up information for the caller. The selection of an Agent 
to receive a call is based on:

Agent availability (Status set to "Available")
Phone state (phone is on hook)
The Agent's skill set (ability) and preference level
The amount of time the Agent's phone has been idle (on hook)

When Agents become available to take calls (by logging in and selecting "Available"), they are marked as "Available" Agents for each 
of their skill-set assignments. 
The goal of the TM-2000 ACD solution is to immediately connect each caller to the most appropriate resource or provide an 
interactive queue for callers when those resources are busy. They may also exit the queue and, upon returning to a menu, select 
among various options like:

Listen to an announcement
Transfer to an extension
Leave a message with callback information and hang up

In order for the TM-2000 IP ACD to effectively route calls and provide the fastest response to the callers, it is critical that the Agent 
positions are available to receive the calls. 
The TM-2000 IP ACD Call Completion Call Center is made up of a number of IP-based modules that have very specific tasks. These 
include:

Event Server Module
ACD Controller Module
Hardware Interface Module (one or more)
Agent Module
Agent SoftPhone Module
Agent Console Module
Reporting Module

This manual discusses the use of one of these modules, the ACD Agent Module, which is used by the Agent to log on and off the ACD 
system. It also discusses the use of this module by an Administrator. 
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Administrator Manual - Usage

About
Below you will find the the Usage Guide. It will go over how an agent should use the Agent Module. 

Color Coding
There are several color coded signals that can be used to easily ascertain information on the T-Metrics ACD Agent Module. For 
example when an agent's line is being used (whether the phone is ringing, a caller is on the line, or a caller is on hold) the Status indic
ator will change from a green Available to a blue Available. 

   

Another indicator that will change colors, depending on the information it is displaying, is the number of agents available for each 
skill (discussed later in the Skillsets section). In the screenshots above, notice that the number of agents available in the "Holiday 
Support" skillset is "7", while the numbers displaying how many agents are available in the "Demonstration2" and "TM_IVR" skillsets 
are "1" and "0" respectively. When the agent detects that there is only 1 agent available in a skill it will display the number 1 with two 
asterisks to the right and it will display in the color Orange. When there are no agents available in a skill, the agent will display a "0" 
with two asterisks and it will display in Red. More information about these features is available in the Status Window and Skillsets 
Window sections.
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Status Window
Shown below is the Agent Module in the Connected to Server State. This is the State that automatically displays when the Agent 
Module is opened if the software successfully connects to the server. The user will not receive calls until they Log On and become 
Available. 

To Log On, simply press the Log On button if your logon name was entered automatically by the system (see above). If your name 
was not already entered, enter your logon name and then press the Log On button. 
The Agent Module automatically detects that the user is an Agent and places them in the "Available" Status, making them ready to 
receive ACD calls. The figure below shows an Agent in the "Available" Status. 
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Status Changes
The Status drop-down menu allows the selection of the Status item. With the exception of the required "Logged Off" and 
"Available" Status items, the rest of the settings are chosen by the Administrator(s) and stored in the ACD Controller database. 
Typical additional settings are "Performing Post Duties" and "Out to Lunch". These settings will make the Agent "unavailable" to 
take calls. An Agent can only receive an ACD call if he/she is in the "Available" Status and the phone is on-hook (idle). Note: If an 
"Available" agent takes a call (off-hook state), the Status will change to a blue "Available" (see above section labeled "Color 
Coding"). 

To change the Status, place the mouse over the drop-down menu in the Status Window and click to show all 
existing Status options. Move the mouse pointer over the appropriate Status and click. The selected Status will then be the only one 
showing. Click on the Change button to complete the process. 

   
Agent Changing Status from Available to Performing Post Duties 

If an Agent is not going to be available to take ACD calls, then it is important for the agent to change their Status to make themselves 
"unavailable" (e.g., Out to Lunch, On Break, Performing Post Duties) so that calls will not ring at that position. Once the agent is 
ready to take ACD calls again, simply change the Status back to Available. Note that when an agent is in an "unavailable" state, 
the Status indicator color changes from green (Status = Available) to yellow (e.g. Status = Performing Post Duties).

Caller ID Window
This Window shows three pieces of data every time the agent has a call routed to them from the ACD. These data are Caller ID, Hold 
Time, and Skillset. 

Caller ID is the number that the caller is calling from. This may include the trunk number that the 10-Digit Number 
is a part of.
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Hold Time is the length of time for which the call has been in the system waiting for an answer from an agent.

Skillset displays the Skill from which the caller needs assistance and thereby caused the ACD to route the caller to 
the agent. For instance, if an agent is a member of both Engineering and Support Skillsets, this indicator will 
display which of these two skills for which the caller is calling.

 

Skillsets Window
This Skillsets Window provides an easy way to view statistics about all the Skillsets to which the user is connected. The Available colu
mn provides the user with how many agents are in the "Available" state for each Skillset listed. The Queue column shows how many 
callers are in the queue for each Skillset waiting for an available agent. The Msgs (Messages) column shows how many (voice) 
messages each Skillset has. 
At the top of the window is a display of the total of calls that are in Queue in the ACD and how many total Customer Messages there 
are. 

 

Expanded Version

Open the Expanded View screen by pressing this button:   

Skills
Columns in the Skills Grid:

Skill – The name of the skill.
Avail – The number of agents with a skill level higher than '0' who are in the available position status.
Rqd (Required) - The number of agents required to be available to meet your service level agreement (SLA). Note 
that this column can only be calculated when there have been at least five calls within the interval being analyzed 
for the SLA calculation.
Level – The viewing agent's skill level in the skill.
In Q (In Queue) – The number of callers in queue for that skill.
Oldest - The length of time that the oldest call in queue has been waiting for that skill.
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Wait Avg - The average length of time that a caller waited in queue before being answered by an agent. The time 
window used is based on just the last four calls that were in queue. The reason for the deviation for this statistic is 
to give relevant information for real-time use. (This number can be more volatile to give a better picture of how 
long people are waiting right now)
Msgs – The number of voice messages (customer callbacks) waiting for processing in the queue.
Total – The total number of calls that have been assigned to the skill. The time window for this statistic is reset 
daily at midnight.
Ansd – The number of calls within 'Total Calls' that were answered by an agent – same time window as Total Calls.
Aban (Abandons) – The number of calls within 'Total Calls' that were not answered by an agent – same time 
window as Total Calls.
AbanAvg (Abandoned Average) – The average length of time that a caller waits for this skill before abandoning. 
The time window used is based on just the last four abandoning callers. The reason for the deviation for this 
statistic is to give relevant information for real-time use. (This number can be more volatile to give a better picture 
of how long people are waiting before hanging up right now)
Aban % (Abandoned Percentage) - The percentage of abandoned calls vs. Total Calls - same time window as 
Total Calls.
ASA (Average Speed of Answer) - The average length of time that a caller waits once assigned to a skill before 
being answered by an agent. This, along with SLA, is based on a special window of time that is adjustable per 
skillset to allow for different standards for different skills.
SLA (Service Level Agreement) - The percentage of calls that were answered within the period of time as defined 
in the Controller module for that skill. This, along with ASA, is based on a special window of time that is adjustable 
per skillset to allow for different standards for different skills.
Group – The name of the group of which the skill is a part. If the skill is not part of a skill group then this column is 
blank.
Off(Skill is Off) – This checkbox is checked if the skill is turned off for the Agent. Administrators are able to assign 
the ability so that an Agent can turn off/on skills at will. This ability can be limited by the Administrators on a per 
skill basis.

Agents
Agent – This column displays all of the Agents which are available to give real time statistics based on the filters 
checked in the Skills Window.
Ext – The extension for the Agent's phone.
Skill – The skill of the last call the Agent took.
Task– This column displays a more specific description of what an Agent is currently involved in. It can display Rea
dy, Unavailable, ACD Call, Non ACD Call In, Non ACD Call Out, and Callback.
State – This column can display an icon and/or text of the current phone state. It can display Idle, On 
Call¸ Ringing, and Hold.
Time – The time that an Agent has been in their current State.
Status– This column displays the Status in which the agent is currently engaged.
Time – The time that an Agent has been in the current Status.
ACD Calls – The number of calls an Agent has taken from the T-Metrics ACD Queue.
ACD Avg – The average length of ACD Calls in minutes : seconds format.
Non-ACD – The number of calls an Agent has taken that were not sent from the T-Metrics ACD Queue.
Non-ACD Avg – The average length of Non ACD Calls in minutes : seconds format
Emails – Shows the number of emails handled by each agent.
Chats- Shows the number of webchats handled by each agent
Call Display – The Caller ID for the last call an Agent took from the T-Metrics ACD Queue.
Status Details-The area where an agent can put a description of what/or whom they are currently working on.



 11

Color Coding Status of Agents

 
Logged On and "Available"

  Logged On and "Available" but on a call

 
Logged On but "Unavailable" (eg. Out to Lunch, etc) 

 
Logged Off 
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Custom Agent Filtering
This allows the supervisor to filter on a specific skill or by selecting one or specific group of person(s). 
Custom Filter- by skill 
Edit Filter- Lets you filter by selecting specific agents 

Start WebRTC Chat
Allows agents or supervisors to chat with each other via a web chat. 

Agent Callbacks Window
The Agent Callbacks window, accessed by choosing the "Edit" menu and then clicking "Agent Callbacks", is used when an Agent is 
working with a caller who will need to call back regarding the same problem. By using this feature, the Agent will be able to give the 
caller specific callback instructions, which will allow the caller to be connected to the same Agent that has helped before. You must 
be active, on an ACD call, to use this feature.

Agent Callbacks Window 

The Agent is able to enter a brief message about the call in the window pane on the right, such as "John Doe is calling back with the 
account information for his checking account"; choose the amount of time the callback will be valid from the Callback Account 
is Valid For list, such as "The remainder of today"; and then click on the Request Callback Account Number button. A Callback PIN 
will appear for the Agent to give to the caller, along with instructions as to what telephone number to call back. 
When the caller returns the phone call to the Agent this screen will reappear and the brief message entered by the Agent will appear 
in the white display list box in the right window pane where it was entered. 
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Emergency Button
Clicking on the Emergency button sends an immediate message to a Supervisor, making him/her aware that a particular Agent is 
having an emergency condition. 

 
Emergency Request Screen Pop

Messaging
The Messaging button is used by an Agent to request help from a Supervisor. Pressing this button brings up a form that allows the 
Agent to enter a text message that is then sent to the Supervisor. The Supervisor can respond and send a text message back to the 
Agent. They can continue sending text messages back and forth until the problem has been resolved. This is very handy when an 
Agent is working with a caller and wants to ask the Supervisor advice on an issue. The Supervisor is able to help the Agent without 
going to the Agent's position or without the caller realizing the Agent is getting help from the Supervisor. 

A message box appears when the Agent clicks on the Messaging button. The Agent then fills out the text area and clicks on 
the Send button to send the message to the Supervisor:
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The Supervisor receives the message and can write a response back to the Agent. 
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Administrator Manual - Menu Bar Items

About
Listed below are the items on the ACD Agent Module menu bar.

File
Server Messages: This displays all messages between the server and the Agent client.

Show Activity Items: This option allows the agent to view all the activity items that are 
tied to each of the skills with which the agent is associated.

Show Expanded View: This opens the expanded view of the Agent Module.

Show Past Caller IDs: This option is used to view caller ID stamps from earlier in the day, 
as opposed to the one currently showing in the Caller ID window

Show Previous CallBack Messages:This function displays a window with a list of 
Customer Callbacks previously delivered to this agent position. The window will display 
the File Name, Caller ID, and Call Time of each Customer Callback. From this screen, a file 
can be selected and, by pressing the Get File button, downloaded to the local computer. 

Show Callback Messages For All Agents:This function displays a window with a list of all 
Customer Callbacks previously delivered to any agent currently logged into the ACD. The 
window will display the File Name, Caller ID, and Call Time of each Customer Callback. 
From this screen, a file can be selected and, by pressing the Get File button, downloaded 
to the local computer. 

Show past Emails:The feature allows the user to show all of the past ACD Emails. The 
window will display the EmailTime, FromAddress, Subject, and Reply Type.

Send New Email:This allows the user to create an email form from their Agent Module. 

Exit: This is used to close the ACD Agent Module and log the Agent off the ACD system. 

Edit

Agent Callbacks: 
This brings up the Agent Callbacks window explained below

Agent Callbacks 

The Agent Callbacks Window, shown below, is used when an Agent is working with a caller who will need to call back regarding the 
same problem. By using this tab selection, the Agent will be able to give the caller callback information, which will allow the caller to 
be directly connected to the same Agent that has helped previously. An Agent must be active on an ACD call, to use this feature. 
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The Agent is able to enter a brief message about the call in the rightmost window, such as "John Doe is calling back with the account 
information for his checking account"; choose the amount of time the callback will be valid from the Callback Account is Valid 
For list, such as "The remainder of today"; and then click on the Request Callback Account Number button. A Callback Account 
code will appear for the Agent to give to the caller, along with instructions as to what telephone number to call back. 
When the call comes back in and is presented back to the Agent, the brief message entered by the Agent will appear in the white 
display box on the right hand side of the screen. 

Settings Menu
Accessed by means of the Edit > Settings, this window allows you to change several settings concerning the ACD Agent Module. The 
first option in the settings window is the Connections and Miscellaneous Settings menu. 

Connection String
Description – The name of the current connection you are currently using
Server Address- The server where events are being sent to.
Connection Port-The current port being used. Please leave this as 21 unless otherwise advised by T-Metrics.
Connection State- the current state of the connection. This should be set to Active.
Interface- The setting of how you are interacting with your phone.

Traditional Fixed – A setting used in conjunction with a standard desk phone. (90% of users will use this setting)
Traditional Dynamic – A setting used in conjunction with a set up where you log into your phone and your number can follow 
you. Your number is not tied to one desk phone.
Microsoft Lync – A setting used in conjunction with the Microsoft Lync Client as the agent phone. There are additional Microsoft 
Lync settings under the Unified Communications section.
TMetric SIP Softphone – A setting used in conjunction with a softphone instead of a handset.

Primary ACD DN – phone number or extension associated with the Agent
ACD Redirects – This setting enables the transfer of calls between instruments on the TM 2000 system.
Secondary ACD DNs (View/Edit) – This is a setting used for sites that have multiple DNs set up at each individual operator station.
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Bubble Forms and System Tray 
Bubble Forms pop up when certain events occur, such as an incoming call or an instant message. From here, the administrator may 
enable/disable the Bubble Form feature, as well as configure the Bubble Forms' fade settings.

Custom Status Thresholds: This feature allows you to set the time limits for position statuses

Audible Alerts: this feature allows a tone to be played for the bubble forms selected in the top menu.

 

Agent Tagging: This allows you to choose triggers or alerts from other agents. For example: if Casey was selected and I chose to be 
alerted when his phone state changed, I'd get a notification every time he answered or hung up from a call.
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Bubble Form for Popup Tools: This lets the user choose the option of receiving the selected pop up bubble form in either a webpage 
layout or through their default browser (like a help ticket) and select if you would like that page to close when the call ends, 
manually, or when the bubble form fades (based on the time selected).

Data Grids
The Data Grid Options menu allows the administrator to customize how information is displayed within the Agent Module.

Grid Formats: 
From here, 
changes may be 
made to the grid 
display, 
concerning grid 
location, 
ordering, font, 
symbols, etc.
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From this menu, the Administrator may also create a Customized Agent Grid Filter, displaying only specified agents.

 

From this menu, the Administrator may also create a Customized Skill Grid Filter, displaying only specified skills.

Greeting Files
From this menu, a user may set which greeting file they wish to play at their station for selected skills.
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Filename – The filename of the audio file to be used as a greeting
Skill – The skill that is to be used with the greeting file
Phonenumber – The phone number of the user
UserName – The agent's username

Instant Messages
From this menu, the user can configure the instant messenger and chat features included in the ACD Agent Module.

Pop Incoming IM's to the Front - This option allows incoming Instant Messages to display in the forefront of the user's screen. It will 
load on top of any other window that is open
Play Sound for Incoming IM's- This option allows an audible sound to play when an instant message is received through the ACD 
Agent Module
Show Status Changes of Other Agents in Instant Message Windows – This option will display the current status of the agent the 
user is messaging in the chat window
Chat Logging - Manually save chat conversation. Select where/what folder you would like your chat conversations to be saved
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Licensing
This menu will show the path to the license file for your software. Please do not change this path, unless you are an Administrator 
who has spoken with a T-Metrics Representative.

Recordings
This menu, is where call recordings are enabled and it will also show you the path of where the recordings will be uploaded to. Please 
do not change this without being an Administrator who has contacted T-Metrics support.

This feature allows supervisors to receive an error message as a bubble form when there are issues monitoring an agents recordings.

Sound Devices
This menu allows the user to choose which sound device will be used in conjunction with the ACD Agent Module software.

Play Device – The audio device used for audio playback for the agent
Recording Device – The audio device used to capture call recordings
Listen Device – The audio device used by a supervisor when listening to an agent's live call.
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1.
2.

Trouble Reports
This menu helps user get in touch with T-Metrics Support easily when experiencing problems. It contains the agent's contact 
information. 

Unified Communications
This menu allows user to configure setting both for T-Metrics Unified Communications (ACD Routed Emails and Social Media). This 
menu also allows user to configure setting both for T-Metrics Unified Communications (WebChat/Enterprise Messaging)

This menu allows user to configure settings through Microsoft Lync.

   

User Interaction
This menu allows the user to make several selections to customize how they will interact with the Agent Module.

Allow Us of Keyboard (Enter Key) to Select Activity Items
Allow Use of Keyboard (Enter Key) to Change Position Status
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3.
4.
5.
6.
7.

Show My Current Status Time Next to My Position Status
Minimize the Agent Module to the System Tray
Confirm with User Prior to Sending Emergency Messages
Disable the Emergency Button
Show Status Details Input Box

The user may also assign Global Hotkeys to perform common actions via keyboard shortcut.

 The user may change the language from the list of options (English/French)

Toggle Skills: 
If an Agent has been given the ability to turn on and off Skills by a Supervisor, this feature will allow the Agent to perform those 
actions. 
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Toggle Skill Groups: 
Allows user to turn a specific skill group on or off. 

Hours of Operation: 
Access by means of Edit > Hours of Operation menus, there are two options Holiday Hours of Operation and Weekday Hours of 
Operation. These windows are interfaces to edit the hours when the TM-2000 ACD processes calls.

Holiday Hours of Operation
This table allows you to define holiday hours for each skill set. You can pick which dates are considered holidays at your place of 
business and then name them individually. You may then define different holiday hours for each holiday on the calendar and a 
different extension for calls to be forwarded to in the event that your place of business is not answering calls during the time that the 
call came on a specific holiday.

 

Weekday Hours of Operation
Similar to the last table, this one allows you to set the hours for every day operation. Instead of the names of holidays, you will see the 
names of the days of the week. You may still specify the Night Service extension to which calls should be forwarded. 
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Information
The Informaer is used to pop up the Information Directory, shown below, which is used to 
access information using a Windows Explorer-type of form. This data can be anything, 
including documents in text and RTF and pictures in such formats as BMP, JPG. Also URL 
address on the web can be accessed through the viewer. You can access this by pressing 
F11 on the keyboard. 
 

Agent

Change Status: 
The Supervisor can change the Status of an Agent simply by highlighting the Agent's name, choosing Agent / Change Status from 
the menu bar and then choosing the appropriate Status settings. Alternatively, a Supervisor can right-click on an agent's name and 
choose the Change Status" option. For example, if an Agent leaves for lunch still in the "Available" Status, the Supervisor can 
change the Agent's Status to "Out to Lunch" without leaving his or her desk. By doing this, the Agent will not receive calls when not 
available. 

The Agent Menu on the Menu Bar is the same as the Agent Menu in the Expanded View. See the Expanded View section for 
details.


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Listen & View:

With the purchase of the additional hardware and software noted above at the Agent and Supervisor/Administrator positions, the 
Supervisor/Administrator can highlight an Agent's name and then select Agent / Monitor / Listen to be able to remotely listen to the 
caller and the Agent. If the Supervisor/Administrator selects Agent / Monitor / View, the Supervisor/Administrator will be able to 
remotely view the Agent's screen. This feature is very beneficial in training new Agents and monitoring Agents for quality control. 

Request Trouble Report: 
This feature will populate a new window which allows you to send a trouble report to TMetrics explaining the current issue/problem 
you are experiencing. 

Send Instant Message: 
Allows the Administrator to send a private instant text message to a particular Agent or to send a broadcast instant text message to 
all Agents. 

Edit Agents and Skills: 
The Administrator can add, edit or delete either Agents or Agents' settings by selecting the Agent / Edit Agent menu item, which 
brings up the Agent Edit Form shown below:

NOTE: The Administrator position must be equipped with the Supervisory Listen & View HASP® key or Soft License and the 
Agent must be equipped with a T-Metrics Agent TAP, SoftPhone or PhoneGroups Console to use this feature. 


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At the main screen of the Edit Agents and Skills form, an Administrator can search for an existing agent account to edit or delete. They 
can also create a new agent account by clicking the New Agent button at the bottom of the Select am Agent to View/Edit section of 
the form. Once an existing agent account is selected or the New Agent button is click, the Administrator can then make the desired 
changes on each of the defined panels. The first panel presented is the General panel as shown below. 

Agent Alias – This is the agent's display name for the system. This item is optional.
Agent Logon Name – This field contains the logon name the user will enter to log into the system. If Windows 
Authentication is configured on the system this value must match the username used to log into the operating 
system.
Administrator Rights – This setting determines if the user will be an Administrator on the system.
Mobile Device ID – This field is used with the Android Agent Module offering and links an Android based device 
with the user account. This item is optional.

Once the Administrator has selected a specific Agent Logon Name, the Skillsets panel can be accessed to bring up the following 
screen in which to Add, Delete or Edit an Agent's skills or skill groups. 

Add/Remove buttons – These buttons are used to add or remove a skillset or skill group record.
Skill – Select the desired skill from the dropdown box of available options.
Skill Level - Select the desired skill level from the dropdown box of available options, where 9 is the most likely to 
receive objects in this skill and 1 is the least likely
Supervisor – This setting is used to enable the agent as a Supervisor of the skill. This item is optional.
Can Turn Skill Off – This setting determines if the agent has the ability to toggle the skill on and off 
themselves. This item is optional.
Skill Is Off – This setting determines if the skill in question is on or off.

The Weights panel, shown above, is displayed when a Contact Center system is configured to use multimedia and is used for defining 
multimedia routing (e-mail, Facebook, Twitter, etc.) on a per agent basis.  At the top of the panel the Total Contact Weight 
Allowed sets the maximum total object weight the agent can accept. The grid below sets the weight of each type of object type for 
the agent selected. This allows for each agent to have their own unique total and object type weights to best mirror their 
proficiencies. 
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The Licensing panel, shown above, is available when the Contact Center system is configured to use the concurrent licenses model. 
The Administrator is able to set the type of licenses the agent will acquire at logon to the system. 

Skill

Log out all agents with skill:
This function will logout all agents who have the selected skill. The user is warned before the action takes place:

NOTE: These licenses are applied at logon so if the settings are edited while an agent is currently logged into the system, the 
changes will not take effect until the next logon.


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Show all agents with skill:
This option shows all agents that are a part of the selected Skillset. You can use the button in the bottom left corner to display either 
all agents or just all agents that are logged in:

Send Instant Message: 
This option launches the Instant Messaging feature allowing the Administrator to message an entire Skillset. This can also be 
accomplished by clicking on the Messaging button and then the Skillset radio button. 
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Help
The Help menu item has Several options under it. We will outline the major actions below. 

On Board Diagnostics:
This is uses to instruct administrators on the benefits & uses for the on board diagnostics tool in the ACD Agent

Get Version Info gives you a system information breakdown.
Troubleshoot problems will open a new window.
Agent Call Recordings: This will test call recordings, whether the recording volume is acceptable, and whether the selected agent 
has permissions to the call recording upload folder.

Select an agent to test.
Click on Begin Test
After running a test you will see success and/or failure messages. If any tests fail, you can click on details to 
find out more information.

Logging into the ACD - If you are unable to log into the Agent module, you can diagnose this here. This test will of course need to be 
run by pulling the On-Board Diagnostics up on a position that is unable to log in.
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Supervisor Listen & View:

Select an agent who is currently on the phone
Click on Begin Test

After running a test you will see success and/or failure messages. If any tests fail, you can click on details to find out 
more information. It will also open a live view of the agent's computer screen, and stream the audio of their active 
call.
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Schedule Diagnostics allows you to schedule a time to run diagnostics as well as edit & delete any previously scheduled tasks.

Email a System Summary

E-Mail a System Summary will create an automated email report.

Send Trouble Report
In the event that a problem occurs, Send Trouble Report is used by an Agent / Supervisor to trap the most recent activity on the 
Agent / Supervisor PC and on the ACD Server that will be forwarded to the T-Metrics Support Staff. 

To make a file that will be sent to T-Metrics, do the following: 

Click on the Help menu at the top of the screen and select the Send Trouble Report option. The screen below will 
appear.
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•
• Follow the on screen instructions and submit the Trouble Report by clicking Send Email to T-Metrics Support, I 

Will Call T-Metrics, or I Will NOT Contact T-Metrics Support.

Agent Module Quick Reference Guide
This function will open a PDF version of the Agent Module Quick Reference Guide. 

Agent Module Supervisor Guide
This function will open a PDF version of the Agent Module Supervisor Guide. 

Agent Module User Guide
This function will open a PDF version of the Agent Module User Guide. 

TM-2000 Reports Package Guide
This function will open a PDF version of the TM-2000 Report Package Guide. 

TM-2000 SSRS Reports Package Guide
This function will open a PDF version of the TM-2000 SSRS Report Package Guide.



 34

Remote Connection and Remote Connection Custom
T-Metrics may request that you use this feature to allow us to remotely control your PC in order to fix an issue. T-Metrics will provide 
you with instructions on how to use this feature should the need arise. 

View Patch Notes
This form will show you all there is to know about the Agent Module since your last update

About Agent Module
About Agent Module is an about box telling who made the product and the version of it. 
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Administrator Manual - Customizable Screen Pop Interfaces

T-Metrics has developed Screen Pop Interfaces for several of our customers. In each instance we have worked with the in-house 
expert from the customer site to develop tools that assist operators in using T-Metrics software in conjunction with their already 
existing systems. 
T-Metrics has been able to successfully integrate several clients like CHCS,Remedy Interface, Magic Interface, and Web Client 
Interface.

Working with a customer to create a useful apparatus, T-Metrics has the ability to create software which will work with an existing 
system. For example, by merging our ACD and a customer service system owned by a customer, it is possible for a customer to enter a 
customer ticket number while they wait in queue and have the system "pop" a screen to the operator at the appropriate time 
bringing up their ticket containing all their information.
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Administrator Manual - MiniTAP

The MiniTAP
The Agent MiniTAP will allow for agent greetings and recording of telephone calls when 
using a Desk Phone. It is also required at each agent position for the Supervisory Listen & 
View feature when the agent is utilizing a desk phone. Additionally, a HASP or soft license 
at the Supervisor position would be required for Supervisory Listen & View functionality. 
When using a hard phone with a headset, an amplifier may be required. Contact T-Metrics 
Support for more information regarding the need for an amplifier. Connections with and 
without an amplifier are shown below.

Picture of the T-Metrics Agent MiniTAP & Connection Diagram
The MiniTAP device sits between the users PC and Desk Phone. The MiniTAP connects to the PC via USB, and then plugs into 
whichever audio hardware port the user wants to use on their Desk Phone (i.e., the handset or headset port).  The actual audio 
hardware will then plug into the front of the MiniTAP.  This allows the MiniTAP to sit between the audio source and the audio 
hardware, capturing the audio and sending it to the PC via USB to be recorded to a file.

MiniTAP with Amplifier MiniTAP without Amplifier

Optional Features 
The T-Metrics Agent module includes several optional features, which may be activated depending on the site's needs, hardware 
setup, and purchased services.
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Administrator Manual - Non-Call ACD Objects

Customer Callback Messages

Completing the Customer Message Information
This option is in place to allow an agent to retrieve Customer Messages (voice messages) left by a caller for a skill manuallywhen the 
system is configured to withhold them until they are requested by an agent. 
Conversely, the system can be configured so that callers can leave a Customer Message that will either be delivered to an "Available" 
Agent when there are no "live" calls to be presented, or delivered to an agent as if it were a live call with its own place in 
queue (depending on the way the system is configured). When a Customer Message is sent to an Agent, the Agent is presented with 
the Customer Message Information window shown below:

 

Figure 28. Customer Message Information Screen Pop 
In order to listen to the Customer Message, the Agent will click on the Listen To Msg button. The Agent's desk phone (either a 
standard phone or a T-Metrics SoftPhone box) will then ring and the Agent will be instructed to "Press any key to play the message".

For Agents using a standard phone set, press any key on the telephone keypad.

For Agents using a T-Metrics Console, go to Telephone Tools on the menu bar, select DTMF Send <CTRL+Alt>, and 
then press any digit on the keyboard.

The Agent can press any key to play the message again.
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Completing the Customer Message Information
When the message has finished playing, the Agent must select one of the other buttons on the Customer Message 
Information window to indicate the action taken in regards to the message:

If the Agent reaches the caller and completes the message, the Agent presses the Customer Called button and the 
window will close. This will mark the call as "Cust Called" in the call records log for reporting purposes.

If the Agent is unable to complete the message (e.g., leaves a message for the caller, etc.), the Agent presses the Cu
stomer Unavailable button and the window will close. This will mark the message as "Cust Unavailable" in the 
call records log for reporting purposes.

Closing the Customer Message Window without Call Resolution Selected

If the Agent closes the Customer Message Information window by selecting the   in the upper right-hand 
corner, the message will be sent back to the Agent to retrieve again. If the Agent receives an incoming call, the 
message will be sent to the Agent when the position is "Available". If the Agent makes his/her position unavailable 
(by selecting "On Break", "Out to Lunch", etc), the message will be routed to the next available Agent.

If the Agent closes the Customer Message Information window by pressing the Close with No Action button, the 
message will be sent back to the Agent to retrieve again. If the Agent receives an incoming call, the message will be 
sent to the Agent when the position is "Available". If the Agent makes his/her position unavailable (by selecting 
"On Break", "Out to Lunch", etc), the message will be routed to the next available Agent.

Agent Messaging 
In addition to sending IM messages to Supervisors, Agents may send IMs to one another, if the Administrator has enabled "IM for All" 
for their skillset on the server:

The Customer Message Information window should not be closed by these methods as it creates reporting errors in the 
call reconciliation process. 


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Figure 29. Agent(s) and Skillset Messaging Window 

When "IM for All" is enabled, the Agent will see two bullet options: Agent(s) and Skillset. Under Agent(s), the Agent may select one or 
several specified agents to whom they may send an IM message. Under Skillset, the Agent may choose to send an IM to ALL agents 
and supervisors with a selected skill. 

Chat Function 
The T-Metrics system also provides the option to use Chat Rooms. Unlike the IM feature, the Chat Rooms offer agents and supervisor 
to have a group discussion. If the site is using a chat server, and that server has been set in the ACD Agent Module's Instant Messaging 
Settings windows (see pages 18-19), then the Agent will see additional options when clicking on the Messaging key:
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Figure 30. Messaging Window with Chat Room selection 

The Agent may select Join a Room, and then select from any of the available public or private rooms currently in operation.
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. 

Figure 31. Chat Room Selection 

If the Agent selects Create a Room, a set-up window will appear, prompting the Agent to provide a Chat Room Name, select whether 
the room will be moderated or unmoderated, whether the room will be public or private, which agents will be allowed to issue 
invitations to the chat. The set-up windows also provided the Agent with the option of setting an initial topic for the chat:

Figure 32. Chat Room Creation 
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T-Metrics Emailer 
The T-Metrics Emailer provides the Agent with a singular communications solution. With the T-Metrics Emailer working in conjunction 
with the TM-2000 IP Platform, and the client's email server, Agents will receive all calls and emails by the same means. Rather than 
juggling their workload between the Agent Module and a separate email client, Agents will receive email messages from their Agent 
Module via pop-up window, when they are not taking calls or are otherwise Available. 
 

Figure 33. Emailer Window 

The Emailer Window:

Email Information: Provides basic information, such as the "To" and "From" address, carbon copy and blind 
carbon copy lists, email subject line and attachments.
Email: The body of the delivered email.
Reply: Where the Agent types their response.
Formatting Tab: Allows the Agent to change basic text formatting in the email
Attachments Tab: Allows the Agent to add/remove files to their response as attachments.
Spam: Allows the Agent to flag the delivered email as spam.
Ignore: If selected, the delivered email will be marked as handled, but a reply is not sent.
Address Book: Opens your email program's address book. (Microsoft Outlook will need to be open and have focus 
to pop the address book.)
Direct Replies Back to Me: When checked, replies to this email chain will be automatically redirected to the agent 
who handled the message, and not placed in the general queue.
Send Reply: Sends the Agent's response.
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Place Back in Queue: Allows the Agent to place an email message back in queue for the next Available Agent (the 

redirecting Agent will be asked to explain why the email is being redirected):

Redirect to Agent: Allows the Agent to redirect the email to another Agent logged into the ACD with the same Skill.  
The redirecting Agent will select an Agent to redirect to from a list of logged in Agents, then be prompted to explain 
why the email is being redirected as in the above screenshot:

Figure 36a. Redirect Reason



3 http://TMetrics.com
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The Agent who receives the redirected email, will also receive a pop-up with the message the previous agent 
noted in the input form:

Alternate Media Channels
The T-Metrics ACD is also capable of interfacing with Twitter, SMS, and webchat objects in the same way that it interfaces with 
emails.  Agents will receive a pop-up window with the contents of the tweet/text/chat, and the ability to:

Respond to the user who initiated the object, such as a Twitter user or customer on the TMetrics.com3 webpage
Place the Object back in queue for another Agent
Mark the source of the Object as Spam
Ignore the Object, dismissing it from their Agent Module and readying them to receive another call or Object

The Web Chat also has additional functionalities such as maintaining a list of commonly used Agent responses to drag and drop into 
the chat window, seen below on the left, as well as inviting other Agents to the chat.

http://TMetrics.com
http://TMetrics.com
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Webchat

Twitter
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SMS

Outbound SMS
Agents can initiate SMS messages using the File → Send New SMS menu item in the Agent Module. To send an SMS, follow the 
directions below.

Select the skill from which to send the message. A skill is tied to a phone number in the Multimedia Manager.
Enter the phone number of the destination. Note that the country code needs to be included. 

ex: If sending a text message to 704-525-5551, enter 17045255551.
Country codes can be found here - https://www.internationalcitizens.com/international-calling-codes/.

Enter the message, up to 160 characters.
Click Send.

If multiple SMS messages are to be sent, click Send Another to keep the SMS window open after clicking 
Send. 

https://www.internationalcitizens.com/international-calling-codes/
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Administrator Manual - Hours of Operation

About
This document details how an Administrator in the Agent Module can set the Weekday Hours of Operation and the Holiday Hours of 
Operation through the Agent interface

Accessing the Interface
Both of these options are located under Edit > Hours of Operation, which is then broken into Weekday Hours and Holiday Hours:
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Weekday Hours of Operation

Skill: Hours of operation are based on skills in the system, which are populated in the Skill drop-down of this window. A few things to 
note:

This drop-down only contains skills that are assigned to your Agent Account
Many menus use a generic skill ending in _IVR to check Hours of Operation as soon as a caller enters a menu

This is usually the most efficient skill to put Hours of Operation on, however hours applied to actual skill 
names will still be checked and routed accordingly.  The key difference to note here is that _IVR skills are 
typically checked as soon as a caller enters the menu, whereas normal skills are checked right before 
sending the caller to queue.  Functionally, this means that setting the hours on an _IVR skill will prevent 
callers from hearing any of the day menu, instead being sent immediately to the Night Service Number
treatment, whereas setting them on a normal skill will let a caller go all the way through the day menu up 
until they press the option for that skill, where the hours check will then run and the caller will then be sent 
to the Night Service Number treatment.

Day Name: Simply the day of the week that these hours should apply to.

Start Time: This is the time (in Military Time) that the menu should open.  If we're closing the menu for the day, this should be set to 
the same exact time as the End Time.

End Time: This is the time (in Military Time) that the menu should close.  If we're closing the menu for the day, this should be set to 
the same exact time as the Start Time.
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Night Service Number: This is the setting that determines where to send the caller when their call falls outside of the designated 
hours for a skill.  Clicking this field opens the following window:

The File Name and JSON options are not typically used, so we will focus on IVR and Phone Number:

IVR: This stands for Interactive Voice Response, and means that we are sending the caller to another place in the 
phone menu, almost always the Night Menu.  The Data field should be populated with the CallStarted number of 
the menu we'd like to send the caller to; if this number is not known, please reach out to T-Metrics support and 
we'll be happy to provide it.  In the above screenshot, this number is 2000 (The "I" is being populated 
automatically because IVR has been selected).
Phone Number: With this option selected, callers who reach this skill check outside of the designated hours will 
be immediately transferred to whatever phone number is entered into the Data field.  This can be used to navigate 
callers to voice mailboxes or other after-hours services.

Sometimes, these start and end times are confused for the times that the menu should be closed, especially when setting 
hours for early closure days or fully closing the menu. Remember that Start Time is always when the day menu opens up, 
and End Time is always when the day menu closes. If normal hours are 0800 - 1600, and we'd like to close early at 1200 for a 
day, the Start Time should be 0800 and the End Time should be 1200. If we're fully closing the menu, the Start Time and 
End Time should be the same, so that the day menu opens and closes in the same second, or is in other words never open to 
callers.


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Holiday Hours of Operation

Skill: Hours of operation are based on skills in the system, which are populated in the Skill drop-down of this window. A few things to 
note:

This drop-down only contains skills that are assigned to your Agent Account
Many menus use a generic skill ending in _IVR to check Hours of Operation as soon as a caller enters a menu

This is usually the most efficient skill to put Hours of Operation on, however hours applied to actual skill 
names will still be checked and routed accordingly.  The key difference to note here is that _IVR skills are 
typically checked as soon as a caller enters the menu, whereas normal skills are checked right before 
sending the caller to queue.  Functionally, this means that setting the hours on an _IVR skill will prevent 
callers from hearing any of the day menu, instead being sent immediately to the Night Service Number
treatment, whereas setting them on a normal skill will let a caller go all the way through the day menu up 
until they press the option for that skill, where the hours check will then run and the caller will then be sent 
to the Night Service Number treatment.

Date: This should be the exact date of the Holiday in question, in MM/DD/YYYY format.

Day Name: The name of the holiday.  This does not have functional application, but should be descriptive enough for administrator 
purposes.

Start Time: This is the time (in Military Time) that the menu should open.  If we're closing the menu for the day, this should be set to 
the same exact time as the End Time.

End Time: This is the time (in Military Time) that the menu should close.  If we're closing the menu for the day, this should be set to 
the same exact time as the Start Time.
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Night Service Number: This is the setting that determines where to send the caller when their call falls outside of the designated 
hours for a skill.  Clicking this field opens the following window:

The File Name and JSON options are not typically used, so we will focus on IVR and Phone Number:

IVR: This stands for Interactive Voice Response, and means that we are sending the caller to another place in the 
phone menu, sometimes the Night Menu and other times a dedicated Holiday Menu.  The Data field should be 
populated with the CallStarted number of the menu we'd like to send the caller to; if this number is not known, 
please reach out to T-Metrics support and we'll be happy to provide it.  In the above screenshot, this number is 
2000 (The "I" is being populated automatically because IVR has been selected).
Phone Number: With this option selected, callers who reach this skill check outside of the designated hours will 
be immediately transferred to whatever phone number is entered into the Data field.  This can be used to navigate 
callers to voice mailboxes or other after-hours services.

Sometimes, these start and end times are confused for the times that the menu should be closed, especially when setting 
hours for early closure days or fully closing the menu. Remember that Start Time is always when the day menu opens up, 
and End Time is always when the day menu closes. If normal hours are 0800 - 1600, and we'd like to close early at 1200 for a 
day, the Start Time should be 0800 and the End Time should be 1200. If we're fully closing the menu, the Start Time and 
End Time should be the same, so that the day menu opens and closes in the same second, or is in other words never open to 
callers.


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